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Important InformaƟon ‐ When using a convenƟonal style igniƟon coil (Not Coil on Plug) you must use 

StaƟc Suppression IgniƟon Wires with this Controller.   

 

CauƟon ‐ Do NOT submerge Controller in liquid or directly wash unit with liquid of any type! (Do NOT spray 

when washing vehicle!) 

 

 It is the responsibility of the purchaser to follow all guidelines and safety procedures supplied with 

this product and any other manufactures product used with this product. It is also the responsibility of the 

purchaser to determine compaƟbility of this device with the vehicle and other components.  

 InducƟon SoluƟons assumes no responsibility for damages resulƟng from accident, improper installa-

Ɵon, misuse, abuse, improper operaƟon, lack of reasonable care, or all previously stated reasons due to in-

compaƟbility with other manufacturer's products. 

 InducƟon SoluƟons assumes no responsibility or liability for damages incurred from the use of prod-

ucts manufactured or sold by InducƟon SoluƟons on vehicles used for compeƟƟon racing. InducƟon SoluƟons 

neither recommends nor approves the use of products manufactured or sold by InducƟon SoluƟons on vehi-

cles which may be driven on public highways or roads, and assumes no responsibility for damages incurred 

from such use. 

 It is the purchaser’s responsibility to check the state and local laws pertaining to the use of Nitrous 

Oxide for racing applicaƟons. InducƟon SoluƟons does not recommend nor condone the use of its products 

for illegal street racing. 

Warranty 

 InducƟon SoluƟons warrants to the original purchaser that the controller shall be free from defects in 

parts and workmanship under normal use for 180 days from the date of purchase. 

 InducƟon SoluƟons obligaƟon under this warranty is limited to the repair or replacement of any com-

ponent found to be defecƟve when returned postpaid to InducƟon SoluƟons. The Controller must be re-

turned with evidence of place and date of purchase or warranty will be void. The warranty will not apply if 

the controller has been installed incorrectly, repaired, damaged, or tampered with by misuse, negligence or 

accident. 
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System Requirements 

OperaƟng system 

 Windows XP Home or Professional with Service Pack 3 installed.  
 

 InformaƟon—if the text is not formaƩed or sized correctly with Windows XP operaƟng system follow the instrucƟons below 
 to adjust the display dots per inch (dpi) seƫng. 
 

 For Windows XP the screen dpi seƫng must be set to default or 96 dpi. 
  1—Open Display in Control Panel. 
   

  2—On the Seƫngs tab, click Advanced. 
 

  3—On the General tab, in the DPI seƫng list, click 96 dots per inch (dpi). 
 

  4—Restart your computer when prompted. 
 
 Windows Vista all versions. 
 
 Windows 7 all versions. 
 
 Windows 8.x all versions. 
 
 Windows 10 all versions. 

SoŌware InstallaƟon Steps 

 The Nitrous Power Controller soŌware is located on the USB flash drive included with the NPC-2006 kit. Plug the USB flash 

drive into an available USB port on the computer. 

 Important—the soŌware must be located and started manually from the USB flash drive. The auto run feature is not imple-

mented to provide increased security. Please follow the steps below to locate the soŌware installaƟon program. 

Please use one of the following methods to open Windows file explorer. 

 

 

 

1—Press the Windows logo key  + e together. 

 

 

 

2—click on the File Explorer icon in the task bar. 

 

 

3—click Start, point to All Programs, point to Accessories, and then click Windows Explorer. 
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LeŌ click on the InducƟon SoluƟons Drive. 

Double click on NPC-2006_Setup  
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Click on the “Next” buƩon and follow the installaƟon wizard prompts as needed. 

 

Important—Please allow the installaƟon wizard to install the soŌware in the default locaƟon when prompted. 

 

You may be prompted to allow installaƟon from an unknown publisher, click on “Yes” to conƟnue with installaƟon. 

 

Allow the installaƟon program to complete. 

On the Windows desktop you will find a “Nitrous Power Controller” icon. 

Double click to start the soŌware. 
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General Overview 

Menu bar 

Toolbar menu 
Hover mouse cursor over icon for 
informaƟon. Tabbed navigaƟon buƩons 

Progress bar– this pro-

vides visual feedback for 

read and write operaƟons 

to the controller through 

the USB interface. 

USB connecƟon status– this 

indicates a valid USB connec-

Ɵon has been established with 

the controller. 

Firmware version—this indi-

cates the current firmware 

installed in the controller. 

Current setup file in use. 

Click on the “I” buƩons for help. 
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File Menu 

Open File—open setup file that has been previously saved to the computer. 

Save File—save current setup file to computer. This opƟon saves the current setup data from the Nitrous Power 

Controller soŌware. It does not save the setup data from the controller to the computer. 

Save As—save current setup file to computer with the opƟon to save as a copy with a different name. 

Exit—Exit and close the Nitrous Power Controller soŌware. 

Controller Menu 

Important—the controller must be connected to the computer with the USB cable and the controller must be 

powered up to use the following menu selecƟons. Only the Switched +12V power (key on) needs to be on for 

USB communicaƟon, the arming switch should be in the off posiƟon. 

Always allow the progress bar in the lower leŌ corner to complete aŌer starƟng a download or upload to the 

controller. 

Download Setup from Controller—read setup data from the controller to the Nitrous Power Controller soŌ-

ware. Note—aŌer downloading the setup data from the controller you may use the File Menu, Save File selec-

Ɵon to save the setup data to a file on the computer. 

Upload Setup to Controller—write current setup data from the Nitrous Power Controller soŌware to the con-

troller. Note—to load a saved setup file from the computer to the controller, first use File Menu, Open File to 

load the file. AŌer opening the file use this selecƟon to write the setup to the controller. 

Download Data Log from Controller—read data log informaƟon from the controller. This selecƟon will read the 

most recent data log informaƟon from the controller. Note—the controller will retain the last data logged even 

if the controller is powered off. 

Update Controller Firmware—load a new firmware image file into the controller. The firmware is the operaƟng 

system for the controller. When a new and/or updated version is released that has addiƟonal features, or a fix 

for an unforeseen issue, this selecƟon is used to apply the update to the controller. 
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Preferences Menu 

Load Last File on Startup—if the opƟon is selected (checkmark present) the most recent setup file will be auto-

maƟcally opened when the Nitrous Power Controller soŌware is launched. Note—if the file does not exist or 

has been moved to a new locaƟon the default setup will opened. 

Data Menu 

Help Menu 

Open Data Log File—open a data log file that has been previously saved to the computer. 

Save Data Log File—save data log informaƟon to a file on the computer. To save data log informaƟon from the 

controller to a file. First use Controller Menu, Download Data Log from Controller and then use this selecƟon to 

save the data log informaƟon to the computer. 

About—this selecƟon displays a small window with soŌware version informaƟon. 
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Stage1 Tab—Setup 

 

 

Stage1 Delay Timer - this seƫng sets the delay Ɵme in seconds before Stage1 starts aŌer AcƟvaƟon. 

Valid range - 0.000 to 10.000 in .001 second increments. 
 

 

 Note—If the RPM window feature is enabled and the engine 

is not running the solenoids can be dry fired for tesƟng. Once 

an RPM signal is present the solenoids will only fire at the 

desired RPM range.  

 

 

Enable Stage1 RPM control - this seƫng enables a RPM Window funcƟon for Stage1. 
 

Stage1 Minimum RPM - this seƫng controls the minimum engine RPM that must be achieved before Stage1 will turn On. A seƫng of 

0 will disable the Minimum RPM funcƟon and the Maximum RPM seƫng will be used to turn off Stage1 if the engine RPM exceeds the 

seƫng. 

Valid range - 0 to 15,900 RPM in 10 RPM Increments. 
 

Stage1 Maximum RPM - this seƫng controls the maximum engine RPM that Stage1 remains On. When the engine RPM exceeds this 

seƫng Stage1 will be turned Off. The Maximum RPM must be at least 100 RPM greater than the Minimum RPM seƫng. 

Valid range - 1000 to 16,000 RPM in 10 RPM increments. 

 
 

 

 

 
 

 

Synchronize Solenoid Pulse Frequency 

All Solenoids use Stage1 Nitrous pulse frequency (hertz) - this seƫng forces all solenoid outputs to operate at the Stage1 Nitrous Sole-

noid Pulse Frequency seƫng. The controls to adjust individual solenoid output frequencies will be disabled when this seƫng is On. 
 

Stage1 Synchronize Pulse Frequency - the Stage1 nitrous and fuel solenoids can be configured to funcƟon at the nitrous solenoid fre-

quency only (both Stage1 outputs synchronized). Or the Stage1 nitrous and fuel solenoid output frequencies may be set independent-

ly. 
 

IMPORTANT - if you choose to operate the nitrous and fuel solenoids at different frequencies (hertz) you MUST insure that both sole-

noids operate as desired in the delivery of nitrous and fuel to the engine! 
 

InformaƟon - the solenoid pulse frequency (hertz) is how many Ɵmes per second the solenoids open and close when not at 0 or 100 

percent operaƟon. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 Ɵmes per sec-

ond. Total Ɵme for each pulse = 1 / 10 = .1 second, total Ɵme solenoid would be on = .1 * .50% = .05 second. 
 

There are many different styles of solenoids available and they will react differently to changes in the operaƟng frequency. It is up to 

the user to verify that the solenoids are opening properly with the seƫngs used for operaƟon 
 

As a general rule a lower frequency seƫng will allow a solenoid to open properly when a high nitrous pressure is used and a low 

starƟng percentage. This is just a general rule, test your seƫngs! 
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Stage1 Tab—Nitrous Graph 

Graph Control EdiƟng 

LeŌ click on a data point to enable ediƟng for that data point. LeŌ click and drag to adjust the value of the selected data 

point. Click on the graph or another data point to disable the current edit point. 

Double leŌ click on a data point to set an anchor point, once the anchor point is set leŌ click on another data point and 

when the value is changed the graph will auto fill between the anchor point and the current edit point. Click on the anchor 

point or anywhere in the graph to clear the anchor point. 

Once the graph is the acƟve control (click on graph) the keyboard may also be used to edit the data points. 

CTRL+S - set edit point to center of graph data. 

LeŌ and Right keys - move the current edit point leŌ or right. 

Up Arrow and Down Arrow - adjust current data point up or down in 1% increments. 

CTRL + Up Arrow and CTRL + Down Arrow - adjust current data point up or down in .1% increments. 

ENTER - set anchor point at current edit point. No acƟon if there is no current edit point. 

ESC - clear edit and anchor point(s). 

Note—the Stage1 Fuel graph ramp will appear in the background to provide a visual reference.  

Edit point 

Use this feature to Copy the contents of the graph control to other graph 

controls. 
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Important—if the “All Solenoids use Stage1 Nitrous pulse frequency.” opƟon is checked this seƫng will control all nitrous 

and fuel solenoid frequency (hertz). See Stage1 Setup and Stage2 Setup for more informaƟon. 

The solenoid pulse frequency (or also known as Hertz) is how many Ɵmes the solenoids open and close when not at 0 or 100 percent 

operaƟon. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 Ɵmes per second. Total 

Ɵme for each pulse = 1 / 10 = .1 second, total Ɵme solenoid would be on = .1 * .50% = .05 second. 

Resume Start Percent - This seƫng determines the percent the Stage1 Nitrous resumes at if the user has to liŌ the throƩle during AcƟ-

vaƟon. This seƫng is only valid if the Hold And Wait opƟon is ON. This seƫng is used with the Resume Percent per Pulse seƫng to 

build a Resume Ramp. If the Resume Start Percent is greater than the current output percent the resume ramp is ignored. 

Valid range - 10% to 100% in .1% increments. A seƫng of 100% disables this feature. 

Resume Percent per Pulse - This seƫng determines the rate at which the Nitrous Resumes if the user liŌs the throƩle during AcƟva-

Ɵon. This seƫng is used with the Resume Start Percent to build a Resume Ramp. This allows the user to adjust how quick the nitrous 

comes back on if the AcƟvaƟon signal is removed. 

 Example - 10% per pulse would increase the rate 10% for each pulse starƟng at the Resume Start Percent seƫng. 35% Resume and 

then each pulse of the solenoid would increment 10% unƟl the seƫng in the ramp is is achieved. AŌer the resume ramp is completed 

the normal build Ɵme ramp is followed. 

Valid range - 10% to 50% in .1% increments. 

Quick Ramp Builder - Use this selecƟon to do quick progressive setups. This feature allows the nitrous to be setup using a Start Per-

centage, Final Percentage, and a Build Time. 

Start Percentage - This seƫng determines the ramp StarƟng Percentage. The Start Percent can be less than or greater than the Final 

Percent seƫng. If the Start Percent is greater than the Final Percent the ramp will progress backwards. 

Valid range - 0% to 100% in .1% increments. 

Final Percent - This seƫng determines the ramp Final Percentage. The Final Percent can be less than or greater than the Start Percent 

seƫng. If the Start Percent is greater than the Final Percent the ramp will progress backwards. 

Valid range - 0% to 100% in .1% increments. 

Build Time - This seƫng determines the Ɵme it takes for the nitrous to ramp from the Start Percent to the Final Percent seƫngs. A 

short Build Time will make the nitrous ramp more aggressive and a longer Build Time will make it less aggressive. 

Valid range - .200 to 9.900 seconds in .1 second increments. 
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Stage1 Tab—Fuel Graph 

Graph Control EdiƟng 

LeŌ click on a data point to enable ediƟng for that data point. LeŌ click and drag to adjust the value of the selected data 

point. Click on the graph or another data point to disable the current edit point. 

Double leŌ click on a data point to set an anchor point, once the anchor point is set leŌ click on another data point and 

when the value is changed the graph will auto fill between the anchor point and the current edit point. Click on the anchor 

point or anywhere in the graph to clear the anchor point. 

Once the graph is the acƟve control (click on graph) the keyboard may also be used to edit the data points. 

CTRL+S - set edit point to center of graph data. 

LeŌ and Right keys - move the current edit point leŌ or right. 

Up Arrow and Down Arrow - adjust current data point up or down in 1% increments. 

CTRL+Up Arrow and CTRL+Down Arrow - adjust current data point up or down in .1% increments. 

ENTER - set anchor point at current edit point. No acƟon if there is no current edit point. 

ESC - clear edit and anchor point(s). 

Note—the Stage1 Nitrous graph ramp will appear in the background to provide a visual reference.  

Anchor point 

Edit point 

Stage1 Nitrous ramp 

Use this feature to Copy the contents of the graph control to other graph 

controls. 
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Important—the “All Solenoids use Stage1 Nitrous pulse frequency.” opƟon must be un-checked (off) When this feature is 

enable the Stage2 solenoid frequency (hertz) can be adjusted independently of the Stage1 frequency (hertz). 

The solenoid pulse frequency (or also known as Hertz) is how many Ɵmes the solenoids open and close when not at 0 or 100 percent 

operaƟon. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 Ɵmes per second. Total 

Ɵme for each pulse = 1 / 10 = .1 second, total Ɵme solenoid would be on = .1 * .50% = .05 second. 

Resume Start Percent - This seƫng determines the percent the Stage1 Fuel resumes at if the user has to liŌ the throƩle during AcƟva-

Ɵon. This seƫng is only valid if the Hold And Wait opƟon is ON. This seƫng is used with the Resume Percent per Pulse seƫng to build 

a Resume Ramp. If the Resume Start Percent is greater than the current output percent the Resume Ramp is ignored. 

Valid range - 10% to 100% in .1% increments. A seƫng of 100% disables this feature. 

Resume Percent per Pulse - This seƫng determines the rate at which the Fuel Resumes if the user liŌs the throƩle during AcƟvaƟon. 

This seƫng is used with the Resume Start Percent to build a Resume Ramp. This allows the user to adjust how quick the fuel comes 

back on if the AcƟvaƟon signal is removed. 

 Example - 10% per pulse would increase the rate 10% for each pulse starƟng at the Resume Start Percent seƫng. 35% Resume and 

then each pulse of the solenoid would increment 10% unƟl the seƫng in the ramp is is achieved. AŌer the resume ramp is completed 

the normal build Ɵme ramp is followed. 

Valid range - 10% to 50% in .1% increments. 

Quick Ramp Builder - Use this selecƟon to do quick progressive setups. This feature allows the fuel to be setup using a Start Percent-

age, Final Percentage, and a Build Time. 

Start Percentage - This seƫng determines the ramp StarƟng Percentage. The Start Percent can be less than or greater than the Final 

Percent seƫng. If the Start Percent is greater than the Final Percent the ramp will progress backwards. 

Valid range - 0% to 100% in .1% increments. 

Final Percent - This seƫng determines the ramp Final Percentage. The Final Percent can be less than or greater than the Start Percent 

seƫng. If the Start Percent is greater than the Final Percent the ramp will progress backwards. 

Valid range - 0% to 100% in .1% increments. 

Build Time - This seƫng determines the Ɵme it takes for the fuel to ramp from the Start Percent to the Final Percent seƫngs. A short 

Build Time will make the fuel ramp more aggressive and a longer Build Time will make it less aggressive. 

Valid range - .200 to 9.900 seconds in .1 second increments. 
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Stage2 Tab—Setup 

 

 

Stage2 Delay Timer - this seƫng sets the delay Ɵme in seconds before Stage2 starts aŌer AcƟvaƟon. 

Valid range - 0.000 to 10.000 in .001 second increments. 

 
 

Note—If the RPM window feature is enabled and the en‐

gine is not running the solenoids can be dry fired for 

tesƟng. Once an RPM signal is present the solenoids will 

only operate at the desired RPM range.  

 
 

Enable Stage2 RPM control - this seƫng enables a RPM Window funcƟon for Stage2. 
 

Stage2 Minimum RPM - this seƫng controls the minimum engine RPM that must be achieved before Stage2 will turn On. A seƫng of 

0 will disable the Minimum RPM funcƟon and the Maximum RPM seƫng will be used to turn off Stage2 if the engine RPM exceeds the 

seƫng. 

Valid range - 0 to 15,900 RPM in 10 RPM Increments. 
 

Stage2 Maximum RPM - this seƫng controls the maximum engine RPM that Stage2 remains On. When the engine RPM exceeds this 

seƫng Stage2 will be turned Off. The Maximum RPM must be at least 100 RPM greater than the Minimum RPM seƫng. 

Valid range - 1000 to 16,000 RPM in 10 RPM increments. 

 

 
 

 

 

 
 

 

Stage2 Synchronize Pulse Frequency - the Stage2 nitrous and fuel solenoids can be configured to funcƟon at the nitrous sole-

noid frequency (hertz) only (both Stage2 outputs synchronized). Or the Stage2 nitrous and fuel solenoid output frequencies (hertz) 

may be set independently. 
 

Note—this opƟon is only available if the All Solenoids use Stage1 Nitrous pulse frequency is enabled in the Stage1 Setup. 
 

IMPORTANT - if you choose to operate the nitrous and fuel solenoids at different frequencies (hertz) you MUST insure that both sole-

noids operate as desired in the delivery of nitrous and fuel to the engine! 
 

InformaƟon - the solenoid pulse frequency (hertz) is how many Ɵmes per second the solenoids open and close when not at 0 or 100 

percent operaƟon. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 Ɵmes per sec-

ond. Total Ɵme for each pulse = 1 / 10 = .1 second, total Ɵme solenoid would be on = .1 * .50% = .05 second. 
 

There are many different styles of solenoids available and they will react differently to changes in the operaƟng frequency. It is up to 

the user to verify that the solenoids are opening properly with the seƫngs used for operaƟon 
 

As a general rule a lower frequency seƫng will allow a solenoid to open properly when a high nitrous pressure is used and a low 

starƟng percentage. This is just a general rule, test your seƫngs! 
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Stage2 Tab—Nitrous Graph 

Graph Control EdiƟng 

LeŌ click on a data point to enable ediƟng for that data point. LeŌ click and drag to adjust the value of the selected data 

point. Click on the graph or another data point to disable the current edit point. 

Double leŌ click on a data point to set an anchor point, once the anchor point is set leŌ click on another data point and 

when the value is changed the graph will auto fill between the anchor point and the current edit point. Click on the anchor 

point or anywhere in the graph to clear the anchor point. 

Once the graph is the acƟve control (click on graph) the keyboard may also be used to edit the data points. 

CTRL+S - set edit point to center of graph data. 

LeŌ and Right keys - move the current edit point leŌ or right. 

Up Arrow and Down Arrow - adjust current data point up or down in 1% increments. 

CTRL+Up Arrow and CTRL+Down Arrow - adjust current data point up or down in .1% increments. 

ENTER - set anchor point at current edit point. No acƟon if there is no current edit point. 

ESC - clear edit and anchor point(s). 

Note—the Stage2 Fuel graph ramp will appear in the background to provide a visual reference.  

Stage2 Fuel ramp 

Edit point 

Anchor point 

Use this feature to Copy the contents of the graph control to other graph 

controls. 
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Important—the “All Solenoids use Stage1 Nitrous pulse frequency.” opƟon must be un-checked (off) and the “Stage1 Ni-

trous and Fuel Solenoids independent frequency.” must be selected for the feature to enabled. When this feature is ena-

ble the fuel solenoid frequency (hertz) can be adjusted independently of the nitrous frequency (hertz). 

The solenoid pulse frequency (or also known as Hertz) is how many Ɵmes the solenoids open and close when not at 0 or 100 percent 

operaƟon. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 Ɵmes per second. Total 

Ɵme for each pulse = 1 / 10 = .1 second, total Ɵme solenoid would be on = .1 * .50% = .05 second. 

Resume Start Percent - This seƫng determines the percent the Stage2 Nitrous resumes at if the user has to liŌ the throƩle during AcƟ-

vaƟon. This seƫng is only valid if the Hold And Wait opƟon is ON. This seƫng is used with the Resume Percent per Pulse seƫng to 

build a Resume Ramp. If the Resume Start Percent is greater than the current output percent the Resume Ramp is ignored. 

Valid range - 10% to 100% in .1% increments. A seƫng of 100% disables this feature. 

Resume Percent per Pulse - This seƫng determines the rate at which the Nitrous Resumes if the user liŌs the throƩle during AcƟva-

Ɵon. This seƫng is used with the Resume Start Percent to build a Resume Ramp. This allows the user to adjust how quick the nitrous 

comes back on if the AcƟvaƟon signal is removed. 

 Example - 10% per pulse would increase the rate 10% for each pulse starƟng at the Resume Start Percent seƫng. 35% Resume and 

then each pulse of the solenoid would increment 10% unƟl the seƫng in the ramp is is achieved. AŌer the resume ramp is completed 

the normal build Ɵme ramp is followed. 

Valid range - 10% to 50% in .1% increments. 

Quick Ramp Builder - Use this selecƟon to do Quick Progressive setups. This feature allows the nitrous to be setup using a Start Per-

centage, Final Percentage, and a Build Time. 

Start Percentage - This seƫng determines the ramp StarƟng Percentage. The Start Percent can be less than or greater than the Final 

Percent seƫng. If the Start Percent is greater than the Final Percent the ramp will progress backwards. 

Valid range - 0% to 100% in .1% increments. 

Final Percent - This seƫng determines the ramp Final Percentage. The Final Percent can be less than or greater than the Start Percent 

seƫng. If the Start Percent is greater than the Final Percent the ramp will progress backwards. 

Valid range - 0% to 100% in .1% increments. 

Build Time - This seƫng determines the Ɵme it takes for the nitrous to ramp from the Start Percent to the Final Percent seƫngs. A 

short Build Time will make the nitrous ramp more aggressive and a longer Build Time will make it less aggressive. 

Valid range - .200 to 9.900 seconds in .1 second increments. 
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Stage2 Tab—Fuel Graph 

Graph Control EdiƟng 

LeŌ click on a data point to enable ediƟng for that data point. LeŌ click and drag to adjust the value of the selected data 

point. Click on the graph or another data point to disable the current edit point. 

Double leŌ click on a data point to set an anchor point, once the anchor point is set leŌ click on another data point and 

when the value is changed the graph will auto fill between the anchor point and the current edit point. Click on the anchor 

point or anywhere in the graph to clear the anchor point. 

Once the graph is the acƟve control (click on graph) the keyboard may also be used to edit the data points. 

CTRL+S - set edit point to center of graph data. 

LeŌ and Right keys - move the current edit point leŌ or right. 

Up Arrow and Down Arrow - adjust current data point up or down in 1% increments. 

CTRL + Up Arrow and CTRL + Down Arrow - adjust current data point up or down in .1% increments. 

ENTER - set anchor point at current edit point. No acƟon if there is no current edit point. 

ESC - clear edit and anchor point(s). 

Note—the Stage2 Nitrous graph ramp will appear in the background to provide a visual reference.  

Use this feature to Copy the contents of the graph control to other graph 

controls. 
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Important—the “All Solenoids use Stage1 Nitrous pulse frequency.” opƟon must be un-checked (off) and the “Stage2 Ni-

trous and Fuel Solenoids independent frequency.” must be selected for the feature to enabled. When this feature is ena-

ble the fuel solenoid frequency (hertz) can be adjusted independently of the nitrous frequency (hertz). 

The solenoid pulse frequency (or also known as Hertz) is how many Ɵmes the solenoids open and close when not at 0 or 100 percent 

operaƟon. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 Ɵmes per second. Total 

Ɵme for each pulse = 1 / 10 = .1 second, total Ɵme solenoid would be on = .1 * .50% = .05 second. 

Resume Start Percent - This seƫng determines the percent the Stage2 Fuel resumes at if the user has to liŌ the throƩle during AcƟva-

Ɵon. This seƫng is only valid if the Hold And Wait opƟon is ON. This seƫng is used with the Resume Percent per Pulse seƫng to build 

a Resume Ramp. If the Resume Start Percent is greater than the current output percent the Resume Ramp is ignored. 

Valid range - 10% to 100% in .1% increments. A seƫng of 100% disables this feature. 

Resume Percent per Pulse - This seƫng determines the rate at which the Nitrous Resumes if the user liŌs the throƩle during AcƟva-

Ɵon. This seƫng is used with the Resume Start Percent to build a Resume Ramp. This allows the user to adjust how quick the fuel 

comes back on if the AcƟvaƟon signal is removed. 

 Example - 10% per pulse would increase the rate 10% for each pulse starƟng at the Resume Start Percent seƫng. 35% Resume and 

then each pulse of the solenoid would increment 10% unƟl the seƫng in the ramp is is achieved. AŌer the resume ramp is completed 

the normal build Ɵme ramp is followed. 

Valid range - 10% to 50% in .1% increments. 

Quick Ramp Builder - Use this selecƟon to do quick progressive setups. This feature allows the fuel to be setup using a Start Percent-

age, Final Percentage, and a Build Time. 

Start Percentage - This seƫng determines the ramp StarƟng Percentage. The Start Percent can be less than or greater than the Final 

Percent seƫng. If the Start Percent is greater than the Final Percent the ramp will progress backwards. 

Valid range - 0% to 100% in .1% increments. 

Final Percent - This seƫng determines the ramp Final Percentage. The Final Percent can be less than or greater than the Start Percent 

seƫng. If the Start Percent is greater than the Final Percent the ramp will progress backwards. 

Valid range - 0% to 100% in .1% increments. 

Build Time - This seƫng determines the Ɵme it takes for the fuel to ramp from the Start Percent to the Final Percent seƫngs. A short 

Build Time will make the fuel ramp more aggressive and a longer Build Time will make it less aggressive. 

Valid range - .200 to 9.900 seconds in .1 second increments. 
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Timer Stage1 Tab 

Stage1 Timer, Timing Retard Control - this seƫng configures the Stage1 Timer, +12V output to be On whenever Stage1 Nitrous 

is On (Solenoids funcƟoning). Check to enable. 

If this seƫng is Off then the Timer1 output can be configured by selecƟng which control parameters are used to turn On the output. 

When more than one control parameter has been selected all must meet the condiƟons as configured before the output will funcƟon. 

Example - AcƟvaƟon Input Enabled and RPM Enabled, RPM On = 2000 and RPM Off = 4000, the Timer1 output will only be on when the 

AcƟvaƟon Input is acƟve and the engine rpm is between 2000 and 4000 rpm. 

This output supplies +12V when On. 

This output may be used to drive an external relay with a load of no more than 1 amp. The relay can then be used to control another 

stage of nitrous with no progressive ramp. 

Timer Stage1 ConfiguraƟon - check to enable which control parameters are used to deter-

mine when the Stage1 Timer +12V output will be On. This output supplies +12V when On.  

Any opƟons that are selected are combined to determine if the output should be on or off. 

Note—the “Timing Retard Control” must be un‐checked (off) for these features to 

be enabled. 

Delay Timer - these seƫngs control the Delay Ɵme and On Ɵme 

for the Timer output. 

Valid range - 0.000 to 10.000 in .001 Second increments. 

Engine RPM - these seƫngs control the output based on Engine 

RPM. 

Valid range - 0 to 16000 in 10 RPM increments. 

Stage2 Nitrous Percent - these seƫngs control the output 

based on Stage2 Nitrous Percent. 

Valid range - 0.0 to 100.0 in .1 Percent increments. 

Stage2 Fuel Percent - these seƫngs control the output based on 

Stage2 Fuel Percent. 

Valid range - 0.0 to 100.0 in .1 Percent increments. 

Stage1 Nitrous Percent - 

these seƫngs control the 

output based on Stage1 

Nitrous Percent. 

Valid range - 0.0 to 100.0 

in .1 Percent increments. 

Stage1 Fuel Percent - these 

seƫngs control the output 

based on Stage1 Fuel Per-

cent. 

Valid range - 0.0 to 100.0 

in .1 Percent increments. 
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Timer Stage2 Tab 

Stage2 Timer, Timing Retard Control - this seƫng configures the Stage2 Timer, +12V output to be On whenever Stage2 Nitrous 

is On (Solenoids funcƟoning). Check to enable. 

If this seƫng is Off then the Timer2 output can be configured by selecƟng which control parameters are used to turn On the output. 

When more than one control parameter has been selected all must meet the condiƟons as configured before the output will funcƟon. 

Example - AcƟvaƟon Input Enabled and RPM Enabled, RPM On = 2000 and RPM Off = 4000, the Timer2 output will only be on when the 

AcƟvaƟon Input is acƟve and the engine rpm is between 2000 and 4000 rpm. 

This output supplies +12V when On. 

This output may be used to drive an external relay with a load of no more than 1 amp. The relay can then be used to control another 

stage of nitrous with no progressive ramp. 

Note—the “Timing Retard Control” must be un‐checked (off) for these features to 

be enabled. 

Timer Stage1 ConfiguraƟon - check to enable which control parameters are used to deter-

mine when the Stage1 Timer +12V output will be On. This output supplies +12V when On.  

Any opƟons that are selected are combined to determine if the output should be on or off. 

Delay Timer - these seƫngs control the Delay Ɵme and On Ɵme 

for the Timer output. 

Valid range - 0.000 to 10.000 in .001 Second increments. 

Engine RPM - these seƫngs control the output based on Engine 

RPM. 

Valid range - 0 to 16000 in 10 RPM increments. 

Stage2 Nitrous Percent - these seƫngs control the output 

based on Stage2 Nitrous Percent. 

Valid range - 0.0 to 100.0 in .1 Percent increments. 

Stage2 Fuel Percent - these seƫngs control the output based on 

Stage2 Fuel Percent. 

Valid range - 0.0 to 100.0 in .1 Percent increments. 

Stage1 Nitrous Percent - 

these seƫngs control the 

output based on Stage1 

Nitrous Percent. 

Valid range - 0.0 to 100.0 

in .1 Percent increments. 

Stage1 Fuel Percent - these 

seƫngs control the output 

based on Stage1 Fuel Per-

cent. 

Valid range - 0.0 to 100.0 

in .1 Percent increments. 
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Relay Output Tab 

Relay Output ConfiguraƟon - check to enable which control parameters are used to deter-

mine when the Relay output will be On.  

This output provides a Ground when it is On. 

Maximum current draw is 1 amp. 

Delay Timer - these seƫngs control the Delay Ɵme and On Ɵme 

for the Relay output. 

Valid range - 0.000 to 10.000 in .001 Second increments. 

Engine RPM - these seƫngs control the output based on Engine 

RPM. 

Valid range - 0 to 16000 in 10 RPM increments. 

Stage2 Nitrous Percent - these seƫngs control the output 

based on Stage2 Nitrous Percent. 

Valid range - 0.0 to 100.0 in .1 Percent increments. 

Stage2 Fuel Percent - these seƫngs control the output based on 

Stage2 Fuel Percent. 

Valid range - 0.0 to 100.0 in .1 Percent increments. 

Stage1 Nitrous Percent - 

these seƫngs control the 

output based on Stage1 

Nitrous Percent. 

Valid range - 0.0 to 100.0 

in .1 Percent increments. 

Stage1 Fuel Percent - these 

seƫngs control the output 

based on Stage1 Fuel Per-

cent. 

Valid range - 0.0 to 100.0 

in .1 Percent increments. 
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ConfiguraƟon Tab 

Main Timer - This seƫng controls the Main Timer period. This controls the total Ɵme elapsed before a System Timeout occurs. This 

limits the total amount of Ɵme the solenoids can be On if the AcƟvaƟon signal is never removed. 

Once the Main Timer has Ɵmed out the AcƟvaƟon signal must be removed before the controller may be acƟvated again. 

Valid range - 20 to 300 in 1 second increments. 

Hold & Wait - This seƫng allows the Progressive system to Hold & Wait when the AcƟvaƟon signal is removed. 

Example - the throƩle is liŌed due to wheel spin (AcƟvaƟon signal removed). If Hold & Wait is ON the Progressive system will resume 

at the point where the throƩle was liŌed. See Nitrous and Fuel Resume Ramp for addiƟonal resume features. 

If this opƟon is OFF the Progressive system and All Timers will reset each Ɵme the AcƟvaƟon is removed. 

Clutch/Trans Brake Input Delay Timer - this seƫng controls how long the Clutch/Trans Brake input must be On before accepƟng the 

signal. The clutch input hold delay seƫng is ignored unƟl the controller is AcƟvated. 

Before the controller is AcƟvated the clutch input is recognized in real Ɵme with no delay. 

This seƫng could be used to ignore shiŌs with a manual transmission (1 second) or a very low seƫng would act as noise filter to ignore 

spurious signals (.005 second). 

If a clutch input signal is recieved and accepted aŌer the controller is acƟvated the system will turn off the progressive system and Ɵm-

ers. This would allow the nitrous to be turned Off during a shiŌ and resumed when the clutch is released. 

Valid range - 0.000 to 1.000 in .001 second increments. (0.000 turns this funcƟon OFF) 

Tach Input Pulse Per RevoluƟon - this seƫng determines the number of Tach Pulses per revoluƟon of the crankshaŌ. 

Example - if the Tach Signal input is connected to a common  V8 engine mulƟ-spark igniƟon controller a seƫng of 4 Pulse per Revolu-
Ɵon would be used. 

Common seƫngs are, 

1 Pulse per Two RevoluƟons = modern coil on plug systems with white wire connected to single coil wire. 

1 Pulse per RevoluƟon = single cylinder engine and some twin cylinder motorcycle engines. 

2 Pulse per RevoluƟon = 4 cylinder car and motorcycle engines. 

3 Pulse per RevoluƟon = 6 cylinder engines. 

4 Pulse per RevoluƟon = 8 cylinder engines. 

5 Pulse per RevoluƟon = 10 cylinder engines. 
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Data Tab – Data Setup 
Data Log AcƟvaƟon - these seƫngs determine when the controller begins recording data. 

If more than one opƟon is selected ALL condiƟons must be met before a new data log will 

start. 

Example - AcƟvaƟon input and Clutch/Trans Brake input both selected, a new data log will 

begin recording when both inputs are acƟve. This would be a typical setup when making a 

pass at the track. Once staged the Clutch/Trans Brake would be on, then when the wide 

open throƩle switch goes acƟve the controller would begin a new data log.. 

Example if on a chassis dyno and the Clutch/Trans Brake input is not being used you would 

want to have only AcƟvaƟon input selected to start a new data log.. 

RPM - this seƫng determines the Engine RPM when the controller begins recording data. 

Valid range - 1,000 to 10,000 in 10 RPM increments. 

Data Tab – Data Chart 

Data Log NavaigaƟon and keyboard shortcut keys. 

Right and LeŌ arrow keys - pan cursor right and leŌ, use SHIFT + Right/LeŌ and CTRL + Right/LeŌ keys to pan by small increments. 

I - Zoom in, O - Zoom out. 

LeŌ click on chart Ɵtle at top of window to turn chart ON/OFF in the graph. 

Right click on chart Ɵtle at top of window to set chart opƟons. 

LeŌ click on current chart Ɵtle (top right side of graph) to select next chart. 

Right click on graph to set run start and end Ɵme. 

To change the grouping of chart Ɵtles, hover mouse over top of graph and when the cursor changes, leŌ click and drag graph height up 

or down as desired. 

The graph seƫngs will be saved when the program is closed and reloaded when the program is launched. 

Click Ɵtle to turn on/off Drag chart height here to adjust Ɵtle display 
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Wiring Diagram 

+12V Input Required 
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Transmission Brake/Clutch Input Wiring 

Important InformaƟon—when then Trans-Brake/Clutch input is ON the AcƟvaƟon input will be ignored unƟl the transmission brake or 

clutch is released. This keeps the nitrous OFF when the Trans-Brake/Clutch input is ON and the throƩle is wide open. 

RPM/Tachometer Input Wiring 
Typical aŌermarket CDI igniƟon tachometer wiring. See igniƟon manufacturer instrucƟons for more informaƟon. 

CauƟon—never connect the white tach signal wire directly to the coil negaƟve wire with a mulƟ‐spark igniƟon. 

Connect white tach signal wire 

here when not using a CDI or 

mulƟ-spark igniƟon. 

(white tach signal wire) 

The tach input signal can also be connected to a +5 volt or +12 volt square wave signal on newer fuel injected vehicles. You will need 

to research the vehicle in quesƟon and check to see if the ECM provides a tach (rpm) signal.  You may also purchase an aŌermarket 

tach signal adapter if needed. 

Connect white tach signal wire here. 
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Stage1 +12 Volt Timer Output Wiring 

Stage2 +12 Volt Timer Output Wiring 

Relay Ground Output Wiring 

This output provides +12 volt at 1 amp maximum, there is an internal 1k ohm resistor to ground so the output is not floaƟng when in 

the off state. If your igniƟon and/or igniƟon Ɵming controller is acƟvated by a +12 volt signal the 20ga Blue Stage1 Output wire can be 

connected directly to retard acƟvaƟon. 

Important—always test for proper Ɵming retard operaƟon before spraying nitrous! You can use a Ɵming light or a data logger if it is 

equipped to log igniƟon Ɵming. Do a dry test (engine running, solenoids unplugged) to confirm proper Ɵming retard. 

This output provides +12 volt at 1 amp maximum, there is an internal 1k ohm resistor to ground so the output is not floaƟng when in 

the off state. If your igniƟon and/or igniƟon Ɵming controller is acƟvated by a +12 volt signal the 20ga Purple Stage2 Output wire can 

be connected directly to retard acƟvaƟon. 

Important—always test for proper Ɵming retard operaƟon before spraying nitrous! You can use a Ɵming light or a data logger if it is 

equipped to log igniƟon Ɵming. Do a dry test (engine running, solenoids unplugged) to confirm proper Ɵming retard. 

This output provides a ground with a 1 amp 

maximum load.  

If you are driving an LED shiŌ light and it draws 

less than 1 amp of current it can be connected 

directly to the Brown wire with no relay needed. 

If the load is over 1 amp a relay must be used. 

To control a load greater than 1 amp a relay will need 

to be wired into the system as outlined to the right. 

To control a load greater than 1 amp a relay will need 

to be wired into the system as outlined to the right. 
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Controller Firmware Update 
The NPC-2006 controller can be updated using the USB interface. An update installs new firmware (soŌware) into the controller. 

The firmware update file should be copied to C:\My Documents\Nitrous Power Controller\Firmware Updates so it can be located easily 

during the update process. 

When the controller enters update mode a copy of the current installed firmware will be made and placed into the update file directo-

ry automaƟcally. If an idenƟcal firmware file already exists no second backup copy will be made. 

Important—do not turn off power to the controller or unplug the USB cable during the update process. If this does occur the controller 

will remain in update mode and when the USB connecƟon is established again the update process must be completed from the begin-

ning. 

Important—make sure the nitrous arming switch is off during the firmware update process. 

1—turn power on to the controller and connect the USB cable. Launch the PC soŌware. 

2—Click on “Update Controller Firmware” from the Controller menu. 

3—click on Yes to conƟnue and put the controller into update mode. 

4—once the controller reboots in update mode click on the “Close” buƩon to conƟnue the firmware update process. 

ConƟnued on next page. 
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5—please be paƟent while the controller update conƟnues.  

6—when prompted select the new firmware file to load and click on “Open” 

8—when the firmware update process is complete click on “Ok”. 

7—please be paƟent while the controller update conƟnues.  
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Appendix A—Seƫng up the controller for a run 

1—CreaƟng and saving a user setup file to the PC. 

A—Launch the Nitrous Power Controller soŌware. 

Note—if you have the “Preferences->Load Last File on Startup” opƟon checked the setup file that was open the last Ɵme the soŌware 

was used will automaƟcally be opened when you launch the soŌware. If this opƟon is not selected a default setup will be opened. 

B—Edit the setup as desired. 

C—Save the setup to the PC using “File->Save File” or opƟonally click on the Save File icon on the toolbar. If the setup is being 

saved for the first Ɵme you will be prompted to enter a filename before saving. 

Note—if you want to save the setup file with a new name use “File->Save As” or opƟonally click on the Save As icon on the 

toolbar. 

3—Modifying a setup from the controller. 

A—Connect the USB cable to the controller and the PC. Make sure the controller is powered up. 

Note—you can look at the status bar at the boƩom of the soŌware window to see if the controller is connected. 

B—Download the setup to the PC using “Controller->Download Setup to Controller” or opƟonally click on the Download Setup to Con-

troller icon on the toolbar. 

 

C—Watch the progress bar in the lower leŌ corner to confirm download progress. 

D—Click on “OK” when the download complete message is displayed. 

E—Edit the setup as desired. 

F—The setup may be saved to the PC using “File->Save File” or opƟonally click on the Save File icon on the toolbar.  

G—Upload the setup to the controller using “Controller->Upload Setup to Controller” or opƟonally click on the Upload Setup to Con-

troller icon on the toolbar. 

 

D—Watch the progress bar in the lower leŌ corner to confirm upload progress. 

E—Click on “OK” when the upload complete message is displayed. 

2—Upload a user setup to the controller from a saved file. 

A—Open a setup file from the PC by using “File->Open File” or opƟonally click on the Open File icon on the toolbar. 

B—Connect the USB cable to the controller and the PC. Make sure the controller is powered up. 

Note—you can look at the status bar at the boƩom of the soŌware window to see if the controller is connected. 

C—Upload the setup to the controller using “Controller->Upload Setup to Controller” or opƟonally click on the Upload Setup to Con-

troller icon on the toolbar. 

 

D—Watch the progress bar in the lower leŌ corner to confirm upload progress. 

E—Click on “OK” when the upload complete message is displayed. 

Note—the PC is used to save many setup files, only one setup can be uploaded to the controller at a Ɵme. 

F—The controller is now ready to use with the setup that was saved to the PC. 
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Appendix B—Typical procedure when making a run 

A—Edit and upload a setup to the controller. 

Important—it is the responsibility of the user to create a proper setup for their applicaƟon! 

B—Perform any usual pre-race preparaƟons, clean Ɵres, purge nitrous system, etc. 

C—Make sure nitrous arming switch is on. 

D—When the T-Brake/Clutch Input is on the AcƟvaƟon Input will be ignored unƟl you release the trans brake or clutch. 

Note—as long as the T-Brake/Clutch Input is on you can go wide open for the launch without the progressive nitrous system starƟng. 

Important—if you are using the T-Brake/Clutch Input Delay Timer the T-Brake/Clutch Input will be ignored aŌer the iniƟal launch for 

the amount of  delay Ɵme set for this feature. 

E—Stage the vehicle and launch. 

F—The data log will begin recording once the data recording acƟvaƟon condiƟons are met. 

 1—the default seƫng for data recording acƟvaƟon is the AcƟvaƟon Input only. 

 2—you may configure the controller to only begin recording when the AcƟvaƟon Input and the T-Brake/Clutch are both on. 

 3—you may also configure the controller to begin recording based on engine rpm. 

 Please see the “Data Setup” tab for these opƟons. 

G—AŌer the run you may turn the power off to the controller. The data log will be saved in the controller even with no power for sev-

eral years. 

Note—if you start another run before downloading the data log it will be over wriƩen! 

H—See “Appendix C—Retrieving data log aŌer a run” for more informaƟon. 
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Appendix C—Retrieving data log aŌer a run 

1—Download data log aŌer a run. 

A—Launch the Nitrous Power Controller soŌware. 

B—Connect the USB cable to the controller and the PC. Make sure the controller is powered up. 

Note—you can look at the status bar at the boƩom of the soŌware window to see if the controller is connected. 

C—Download the data log to the controller using “Controller->Download Data Log from Controller” or opƟonally click on the Down-

load Data Log from Controller icon on the toolbar. 

 

D—Watch the progress bar in the lower leŌ corner to confirm upload progress. 

E—When the download is complete a message box will inform you if the current setup in the controller was used when the data was 

logged (same setup used for run). Click OK to conƟnue. 

 1—If the setup has changed from the Ɵme when the run data log was created it will not be saved with the data log to the PC. 

 2—If the setup was used when the run data was recorded it will be saved with the data log to the PC. 

Note—the setup can be loaded from the data log at a later date. For example you return to a track and want the same setup that was 

used on a previous run. See below for instrucƟons to retrieve the setup from a data log file. 

Important—always download the data log  before making any changes to the setup if you wish to have the setup saved with the data 

log. 

F—The save data log window will now open and prompt you to save with the automaƟcally generated file name or you may alter the 

filename before saving. 

G—AŌer saving the data log to a PC file the data graph will open and you can view the run data. 

H—Click on the “Data Graph Help” buƩon for help with the data graph funcƟons. 

 

2—Retrieving setup from data log file saved to PC. 

A—Launch the Nitrous Power Controller soŌware. 

B—Open a data log file from the PC by using “Data->Open Data Log File” or opƟonally click on the Open Data Log File icon on 

the toolbar. 

C—Click on the “Load Setup from Data Log” buƩon. 

 1—If a valid setup was saved with the data log it will be loaded and you can view, edit, save, and/or upload to the controller. 

 2—If the setup was not saved with the data log you will not be able to retrieve it and a message box will appear indicaƟng 

 this. 


